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Preface: 

The Sun Moon Planets Simulation and the accompanying Search Utility are 

provided free for use by anyone with an interest in astronomy. It is based on the 

following: Astronomical Algorithms by Jean Meeus, Astronomy on the Personal 

Computer by Oliver Montenbruck and Thomas Pfleger, VSOP87 by P. Bretagnon 

and G. Francou, SPA by the National Renewable Energy Laboratory, ELP-2000/82 

by M. Chapront and J. Chapront, and Fundamentals of Celestial Mechanics by 

J.M.A. Danby. 

 

Introduction: 

After having taught solar system astronomy for many years, I decided to develop 
a Windows based simulation software called Sun Moon Planets Simulation. This 
program is intended for educational use and amateur solar system observations.  

Sun Moon Planets Simulation is a free program that uses astronomical algorithms 
to solve basic equations in celestial mechanics. The program simulates the orbital 
motion of the planets (Mercury, Venus, Earth, Mars, Jupiter, Saturn, Uranus, and 
Neptune) around the Sun. The planetary motion is solved for any selected day(s) 
and then the data is put into a set of tables for observational applications. 

The tables of solar system data include: 

• Sun - Rise, Transit, Set Times; Ephemeris; Solar Eclipses 

• Moon - Rise, Transit, Set Times; Ephemeris; Moon Phases; Lunar Eclipses 

• Planets - Rise, Transit, Set Times; Ephemeris; Phenomena; Equinox and Solstice 
Dates 
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1: A Quick Overview of SMP Simulation 

 



 

The opening screen of the program displays the daily motions of the planets as 

they orbit around the Sun. Take note of the menu items: File, View, Orbits, 

Tables, Dialogs, Tools, Conversions and Help. This brief overview will discuss 

each menu item. 

 
The program also provides a set of informative tables regarding the Sun, Moon, 

and planets. 

 
Sun Tables include: 

• Sun data such as its distance, equatorial and ecliptic coordinates. 

• Sun rise, transit and set times. 

• Sun ephemeris. 

• Solar eclipse tables. 

 
Moon Tables include: 

• Moon data such as its distance, equatorial and ecliptic coordinates. 

• Moon rise, transit and set times. 

• Moon ephemeris. 

• Daily Moon phase angles. 

• Quarterly phases of the Moon. 

• Lunar eclipse tables. 

 
Planet Tables include (for each major planet): 

• Planet data such as its distance, equatorial and ecliptic coordinates. 

• Planet rise, transit and set times. 

• Planet ephemerides. 

• Planetary phenomena. 

• Earth equinox and solstice dates. 

 
Each of the tables allow you to enter a date (between 1900 and 2100) to 

determine information about the items listed above. 

 

The program also provides a set of tools to change the date or to animate the 

motion of the planets as they orbit the Sun. 

 

 



Menu Items 

File 

 

 

 
The File menu item allows you to open an orbital elements file of data that was 

obtained from the Minor Planet Center. The orbital elements file is used to plot 

the orbit of an asteroid or comet. 

 

 

View 

 

 
 
The View menu item allows you to turn on or off some of the features such as the 

Status Line and Tips regarding the planets and orbital paths. 
 
 

Orbits 

 

 
 

The Orbits menu item allows you to see the following:  



 
Orbiting Planets 

 

 
Earth Moon Sun 

 

 

 



  
Apparent Sun Position 

 

 

 
Skyview with Orbiting Planets 

 



Tables 

 

The Tables menu item contains: Sun Tables, Moon Tables and Planet Tables. 

As described above, these tables provide information regarding the Sun, Moon 

and planets. 

Sun Tables 

 

Moon Tables 



Planet Tables 

 

 

 

 

Dialogs 

 

 
 

This is a collection of dialog boxes that show a particular view of some part of the 

Solar System. It includes an Ecliptic View, Lunar Calendar, Lunar Libration, 

Jupiter’s Moons, Saturn’s Moons, and Saturn’s Rings. 



 

Ecliptic View 

 

 

Lunar Calendar 



 

Lunar Libration 

 

 

 

Jupiter’s Moons 

 

 

 



 

Saturn’s Moons 

 

 

 

Saturn’s Rings 

 



Tools 

 
This menu item provides tools such as Select a Date, Orbital Speed that allows 

you to animate the main screen so that you can observe the planets orbiting the 

Sun. You can also set the Orbital Scale (Zoom). 

 

 
 

 



There is also a tool for Incremental Motion so that you can move forward or 

reverse in time by a day, month. 3 months, 6 months, or a year. 

 

 
 

 
An Offset from Center tool allows you to shift the center of the solar system 

around the screen to improve the view if necessary. 
 

 



Conversions 

 

 
This menu item allows you to make various conversions that are helpful for the 

rest of the program. 

 

  

 



Help 

 
The Help menu item provides information regarding orbit views plus a set of 

Notes and Illustrations that explain some of the terminology. 
 

 

Examples of How to Use this Program 

 
1) The opening screen of the program shows the position of the planets at the 

present date (0 hours UT). Use the menu item Select a Date to change the year 

to the next year or the previous year. Again, note the position of the planets, 

particularly that Earth is still in the same position and Mars has moved 

approximately halfway around its orbital path. Try advancing the month and 

days and note the changing position of the planets. Approximately how long did 

it take for Mercury and Venus to make a complete orbit around the Sun? 

 

Definitions: 

Synodic Period - Time between two successive identical positions of a planet as 

seen from Earth. 

Sidereal Period - True orbital period of a planet, the time required for the planet 

to complete one full orbit of the Sun. 

 

 
2) On the opening screen adjust the vertical slider (right-hand side of screen) to 

about the mid-position. Note all the planets appear to be orbiting in a flat plane. 

This plane is called the Ecliptic. Click on Dialogs and select Ecliptic View. In the 

dialog box click the check box to show the planets. Note how the planets are all 

very close to the blue line (Ecliptic). The blue line gives the RA and Dec of any 

planet, Moon or the Sun at any date. Inside the dialog box adjust the date by 

increasing the month and clicking the Go button. Note the motions along the 

Ecliptic of the Sun, Moon and planets. 



Definition: 

Ecliptic - an imaginary line in the sky that marks the apparent path the Sun follows over 

the course of one year. 

 
3) Click Orbits and select Earth Moon Sun. Note the position of the Moon with respect to 

Earth. Click on Select a Date again and advance the days one at a time to 7 days. How far 

did the Moon go around the Earth? Advance the month by one month. How far did the 

Earth go around the Sun? How far did the Moon go around the Earth? 

 
4) Reset the screen to show planets orbiting the Sun. Set the date to March 20 (or 

March 21 - depending on the year). 

 
Click the menu item Tables and select Sun Tables. Click the tab, Sun Ephemeris and set 

the date to March 20. In the first row of data (Sun Ephemeris tab) note the Date, RA and 

Dec. The RA of the Sun should be close to 0 (or 24) hours. Look at the relative position of 

the Sun with respect to the Earth (see menu item Orbits, Apparent Sun Position). The 

Earth should be directly in-line with the Sun and in opposition to the First Point of Aries. 

Next, find the date when RA of the Sun is equal to 12 hours (in September). Set that date 

for the Orbits, Apparent Sun Position and note that Earth will be in conjunction with the 

First Point of Aries and in-line with the Sun. When the RA of the Sun is equal to 24 hours 

(or 0 hours), Earth be back where it was on March 20. 

 

Definitions: 

Right Ascension (RA) - Right Ascension is measured starting at 0 hours when the Sun is at 

the First Point of Aries. This is where the Sun crosses the celestial equator from south to 

north at the Spring Equinox (also called Vernal Equinox). 
Declination (Dec) - the angular distance of a point north or south of the celestial 
equator. 

 
5) Click menu item Tables and select Planet Tables. In the dialog box click the tab Earth 

Equinox / Solstice Dates. Note the date of the June (Summer) Solstice. Click the screen 

menu item Date and change the month and day to the date shown in the Planet dialog 

box. On the main screen you should see the relative position of the Sun and Earth at the 

Summer Solstice (compared to the direction of the First Point of Aries). Repeat this 

procedure using the dates in the dialog box to see the position of Earth with respect to the 

Sun at the Winter Solstice in December. 



6) Click Orbits and select Earth Moon Sun. Click menu item Tables and select Moon 

Tables. In the dialog box click the tab Quarterly Phases of the Moon. In the listing find 

the date of the next New Moon. Click the menu item Tools, Select a Date and change the 

year, month and day to the date shown in the dialog box. Then close the dialog boxes and 

observe the position of the Earth, Moon and Sun on the Orbits screen. The Moon should 

be in-line (conjunction) with the Sun. Keep in mind that the positions of the Earth and 

Moon were calculated at 0 hours UT but the time of the New Moon may be a few hours 

more or less than that. 

Repeat this procedure to view the position of the Moon at First Quarter, Full Moon and 

Last Quarter. 

You can also observe this using the Ecliptic View dialog box. By changing the dates, you can 

observe the position of the Moon in relation to the Sun. 

 

 
7) Click Orbits and select Earth Moon Sun. Click menu item Tables and select Sun Tables. 

In the dialog box click the tab Solar Eclipse Tables. In the listing find the date of the next 

Total Solar Eclipse. Click the Tools menu item and Select a Date and change the year, 

month and day to the date shown in the Solar Eclipse Table. Then close the boxes and 

observe the position of the Earth, Moon and Sun on the Orbits screen. The Moon should 

be in-line between the Sun and Earth. You may also note in the green text on the top left 

side of the screen that it indicates a New Moon and the Solar Eclipse at a given time UT. 

Note that on the screen the Moon may not be completely in position since the position of 

the Earth and Moon were calculated at 0 hours UT and the solar eclipse probably occurs 

several hours later (solar eclipses don't occur at midnight). 

 

 
8) Click Orbits and select Earth Moon Sun. Click menu item Tables and select Moon 

Tables. In the dialog box click the tab Lunar Eclipse Tables. In the listing find the date of 

the next Total Lunar Eclipse. Click the menu item to Select a Date and change the year, 

month and day to the date shown in the Lunar Eclipse Table. Then close the boxes and 

observe the position of the Earth, Moon and Sun on the screen. The Moon should be in 

opposition to the Sun. You may also note in the green text on the top left side of the 

screen that indicates a Full Moon and the Total Lunar Eclipse at a given time UT. Note that 

on the screen the Moon may not be completely in position since the position of the Earth 

and Moon were calculated at 0 hours UT and the lunar eclipse may occur a few hours 

before or after 0 hours UT (midnight). 

 



9) Click Orbits and select Orbiting Planets. You should be showing the main screen with all 

the planets. Click menu item Tables and select Planet Tables. In the dialog box click the 

tab Planetary Phenomena. From the combo box select the planet Mercury and click the 

Go button. In the listing find the date of the next Superior Conjunction. Click the menu 

item to Select a Date and change the year, month and day to the date shown in the dialog 

box. Then close the boxes and observe the position of the Earth, Mercury and the Sun. To 

improve the view, you might move the vertical slider to the bottom and then use the 

Scale Tool to enlarge the orbits. 

 

 
10) Again, on the main screen with all the planets, click menu item Tables and select 

Planet Tables. In the dialog box click the tab Planetary Phenomena. From the combo box 

select the planet Mars and click the Go button. In the listing find the date of the next 

Opposition. Click the menu item Date and change the year, month and day to the date 

shown in the dialog box. Then close the dialog boxes and observe the position of the 

Earth, Mars, and the Sun. To improve the view, you might move the vertical slider to the 

bottom and then use the Scale Tool to enlarge the orbits. Note the green text on the top 

left side of the screen - Mars at Opposition. 

 
There are many other features in this program for you to discover. Be careful to set the 

dates on the main screen to the dates obtained in the Sun, Moon, and Planet dialog boxes. 

 

 

2: The Minor Planet and Comet Search Utility 

The Minor Planet and Comet Search Utility is also a free program that can be used to 

search the Minor Planet Center for data regarding asteroids or comets. The types of data 

include orbital elements, observations and ephemeris information. 



 
 

 

File 
 

 
 
The File menu item allows you to search for a minor planet (asteroid) or comet. 

The item Open Python + Astroquery File allows you to essentially create your own queries 

for the Minor Planet Center (MPC). 

 

Select a Minor Planet to Search allows you to choose an asteroid from a drop-down list 

and then get its orbital elements, list of observations or an ephemeris. It is a ‘limited’ list 

of asteroids, so that’s why there is the possibility of creating your own query for the MPC. 

 



 
 

Click the button to Get Orbital Elements. The program will use a python script to contact 

the Minor Planet Center and get the requested data. The screen will be black for several 

seconds during the time it is contacting the MPC.  

 

 
 

 

 

Once it has the data, it will return with a text box showing the orbital elements. 

 



 
 

Only the first six items in the orbital elements are actually necessary (plus the Epoch). The 

remaining items are just for general information. These orbital elements are discussed in a 

later section. 

 

You may and probably should Save the Orbital Elements. Put the saved .dat file 

somewhere on the Desktop or in the same folder as Sun Moon Planets Simulation. 

Next, open the program Sun Moon Planets Simulation, go to File and Open Minor Planet 

Orbital Elements File. Open the file that you just saved and you should see the orbit of 

that minor planet (Ceres) on the screen along with its orbital elements. 

 

 



Back to the Search Utility - Select a Comet to Search is essentially the same as for Minor 

Planets above but with a lesser choice of comets. 

 

 

Help 

 

The Help menu item contains a few items that you might find interesting. One in particular 

is the explanation of orbital elements. 

 

 
 

 

There is also one very important item in the Help menu. That is Requirements to Get Data 

from Minor Planet Center. Make sure you read this and install the necessary python 

applications. 

 



 
 

 

 

 

 

 

3. Measures of Time – Julian Day Number 

 
The Julian Day Number (JD) is a continuous, sequential count of days and fractions since 

noon Universal Time (UT) on January 1, 4713 BC. 

 

The Julian Day Number is used mainly in astronomy for easier timekeeping rather than 

calendar dates, which involve different number of days in a month and leap years. 

 

Calculations between two different times, intervals or events using Julian Days is done by 

simple subtraction.  

 

A Julian Day starts at noon, not midnight, and uses floating-point numbers for fractions of 

a day. 

 

For example: 

 

Dec. 16, 2025, at 12 hours (noon), 0 min, 0 sec is equal to 2461026.0 JD 

 

Dec. 17, 2025, at 0 hours (midnight), 0 min, 0 sec is equal to 2461026.5 JD 

 



Dec. 17, 2025, at 12 hours (noon), 0 min, 0 sec is equal to 2461027.0JD 

 

Dec. 18, 2025, at 0 hours (midnight), 0 min, 0 sec is equal to 2461027.5 JD 

 
 

Why do Julian Days start in 4713 BC? 
 
The Julian Period is a chronological system of timekeeping, invented by Joseph Scaliger in 
1582. 
 

It is based on the alignment of three cycles 

- A 28-year solar cycle (the period after which calendar dates and weekdays repeat in 

the Julian calendar). 

- A 19-year lunar cycle or Metonic cycle (after which moon phases approximately 

repeat on the same dates). 

- A 15-year indiction cycle (a Roman tax cycle).  

 

January 1, 4713 BC (Julian calendar) at noon was simultaneously the beginning of all three 
cycles. 
 

The product of the three cycles 19, 28, and 15 is 7,980. It will take 7980 years until all three 

cycles repeat. 

This means AD 2025 is year 6738 of the Julian Period (4713 + 2025 = 6738). 
 
The Julian Day Number is obtained by counting the number of days from January 1, 4713 
BC, at Noon, GMT. 
 
We will be discussing Julian Day Numbers in the following sections. 
 
 
 
 
 
 
 
 
 
 



4. Degrees and Radians 

 
Degrees are generally easier to understand than radians. Degrees are a measure of an 

angle, 90°, 180°, 270°, 360°. But degrees do not tell you anything about length of an arc 

on a circle, or any length. 

Whenever we need to solve any equation that involves more than just an angle, we use 

radians. 

 

For example: the circumference of a circle is 2  r where 2  = 6.28... 

and r is the radius of the circle. The circumference is a length. To say a circle is 360° tells 

us nothing about the circumference. 

 

 

1 radian is when the arclength s is equal to the radius r as shown below. 

 

 
As you can see, radians depend on the length of r and s. 

  

If you want to compare degrees and radians, then use the following equation: 

 

 
Or, in other words, 1 radian is equivalent to 57.32° 

 



So, 3.14 radians =  radians = 180° 

 

and 2  radians = 360° 

 

Converting degrees to radians: Degrees x ( /180) = Radians 

 

Converting radians to degrees: Radians x (180/ ) = Degrees 

 

A degree may also have sub-parts, stated as minutes and seconds.  

A degree can be stated in decimal form, such as 30.5°, or as Degrees, Minutes, Seconds 

(DMS): The DMS form is a sexagesimal (base-60) system where a degree is divided into 

smaller units. There are 60 seconds in a minute and 60 minutes in a degree. 

 

Comparing the decimal form to the DMS form: 30.5° = 30° 30′ 0″. 

 

In astronomy, when measuring Declination, the units are degrees (°), arcminutes (′), and 

arcseconds (″). 

 

A variation of the DMS system in astronomy is used when measuring Right Ascension, it is 

common to use hours, minutes and seconds where 60 seconds equals a minute and 60 

minutes equals an hour, same as on a clock. In this case, an hour would be equal to 15°. 

 

We will see more of this in the next section. 

 

 
 

 

 

 

 

 

 

 

 

 

 



5: What are Orbital Elements? 
 

For any object orbiting around the Sun, its real orbit changes over time due to 

gravitational perturbations and the effects of relativity. By ignoring these physical effects 

and treating the orbit in a simpler sense we can specify a set of orbital elements used to 

describe the position of an object such as a planet, asteroid, or comet as it orbits around 

the Sun. In this arrangement there are only the two bodies, the object and the Sun; there 

are no other external physical influences on the motion of the object. 

 

 

These types of orbits considered in this program are described as classical two-body 

systems and are based on the six Keplerian elements:  

 

• Eccentricity (e) - the shape of an ellipse as compared to a circle.  

For a circle, e = 0; e increases as the circle becomes more elliptical.  

If e = 1 the orbital path is parabolic and if e > 1 it is a hyperbola (these 

geometric shapes are not considered in this program). 

• Semi-major axis (a) - add the perihelion and aphelion distances and divide  

by 2. This is the average distance between the Sun and the object. 

• Inclination (i) - this is the tilt of the ellipse with respect to the ecliptic.  

It is measured at the ascending node. 

•  Longitude of ascending node (Ω) - this is the point where the orbiting  

object passes upward through the ecliptic. 

• Argument of perihelion (ω) - the perihelion is the closest point that the 

object comes to the Sun. The argument of perihelion is the angle from  

the ascending node to the point of perihelion. 

 

 

• Mean anomaly (M) - this is the angle from the perihelion to a point along the 

path of the orbit. The angle is based on the mean average speed of the object 

and the amount of time it has been travelling on that orbital path since it left 

the point of perihelion. The mean anomaly is only a guess at where the object 

is because the speed of the object is not constant - it varies as the object 

orbits around the Sun. 

The mean anomaly is usually specified at a particular time and date (epoch). 

The mean anomaly at epoch states the position of the orbiting object along 

the ellipse at a specific time. 

 



• True anomaly () is not usually specified as one of the six orbital elements. 

The true anomaly is the actual position of the object along the orbital path. 

The true anomaly is solved with Kepler's Equation (M = E - e sin E) where E is 

called the Eccentric anomaly. 

 

  

 

A graphical way of viewing orbital elements. 

 

Eccentricity (e) of an Ellipse 

                 
 

 

In the Sun Moon Planets Simulation, go to the Help menu and Illustrations 

Click the third button down (Perihelion) 

 



 
 

Note the different way of calculating eccentricity than the method shown above. 

 

 

 
Semi-Major Axis (a) and Semi-Minor Axis (b) 

                

 

 

 



 
 

Inclination (i), Longitude of Ascending Node (Ω), Argument of Perihelion (ω),  

Mean Anomaly (M), and True Anomaly () 

 

Notice the red line starting at the center and pointing to the right towards the First point 

of Aries (Vernal Equinox).  This is the point at which the Sun crosses the Celestial Equator 

as it moves from the south to the north along the ecliptic. 

 

Starting at the First Point of Aries observe the green arc going around to the Ascending 

Node. This is Omega (Ω), the Longitude of the Ascending Node. Sometimes, instead of 

Omega or Ω the letter N is used. Think N for Node. Occasionally, the word node is used. 

 

Next, observe the arc from the Ascending Node to the Perihelion. This is omega (ω). It is 

called the Argument of Perihelion.  Occasionally, the word peri is used. 

 

Next, observe the arc from the Perihelion to the Mean Position. 

This angle M is called the Mean Anomaly.  

 

The Date of Elements is often called the Epoch. The Mean Anomaly at Epoch states the 

position of the orbiting object along the ellipse at a specific time. 

 

Note that the Mean Position is close to the True Planet Position. 

 



The angle of the true planet position is called the True Anomaly. To get the True Anomaly, 

we first need to determine the Eccentric Anomaly (E). 

 

The Eccentric Anomaly (E) is solved with Kepler's Equation (M = E - e sin E) where E is the 

Eccentric Anomaly, M is the Mean Anomaly and e is Eccentricity. 
The Eccentric Anomaly (E) is solved using iterative numerical methods since it is a 
transcendental equation with no direct algebraic solution for the eccentric anomaly (E). We 
will discuss the numerical methods later. 
 
The relationship between the Eccentric Anomaly and the True Anomaly is shown below. 
Once you have the Eccentric Anomaly, you can determine the True Anomaly. 

 

 
  

 

Now lets apply these ideas to an orbiting minor planet 
 
Consider the orbit of minor planet Ceres 
 
Open the program, Minor Planet and Comet Search Utility, click File and Select a Minor 

Planet to Search. In the dialog box, combo-box you see Ceres. Click the button to Get 

Orbital Elements. It may take a minute to contact the Minor Planet Center, but you 

should get a text box listing the orbital elements of Ceres as shown below. Note, the 

orbital elements for asteroids and comets changes frequently due mainly to gravitational 

effects from the major planets. 

 

The angle of the Reference Position is called the Eccentric 

Anomaly (E) and angle of the Planet position is the True 

Anomaly (). 

They are related by: 

x = a cos(E) , also 

x = r cos() + e a  

a is the semi-major axis and e is eccentricity 

r is the distance from the Sun to the planet 



 
 

Save these orbital elements to a .dat file and then open up Sun Moon Planet Simulation. 

The Date of Elements (Epoch) shown in the listing above is 2461000.5 JD, that is 

November 21, 2025. Change the date in the Sun Moon Planets Simulation (Tools || Select 

a Date) to Nov. 21, 2025.  

 

 
 

Use the slider on the right side of the window and move it down so that the Tilt angle 

(shown at bottom of window) is about 30°. This will give a proper perspective for the orbit 

of Ceres. 

 

Next, click File and Open Minor Planet Orbital Elements file. Select the orbital elements 

.dat file that you previously saved and open it. You should see: 

 



 
 

Note Ceres on the right-side of the image above and its orbital path in blue. Also, note the 

orbital elements are listed in green on the left-side. 

 

For now, four of the six orbital elements will be considered. They are Inclination (approx. 

10°), Longitude of Ascending Node (approx. 80°), Argument of Perihelion (approx. 73°) 

and the Mean Anomaly (approx. 231°). 

 

We will look carefully at each of these elements, so to begin, use the vertical slider on the 

right-side of the display and set it to about the middle position. Note along the bottom of 

the display the Tilt angle is 0°. You should see the image below. 

 

 
 



Note the orbit of Ceres is shown in blue and that the orbit is inclined at around 10°. The 

orbital elements (green text) on the left shows it at 10.58789°. 

 

The bright part of the orbital path of Ceres as shown on the screen indicates where the 

orbit is above the ecliptic plane. The darker part of the orbital path indicates where the 

orbital path is below the ecliptic plane. 

 

Return the vertical slider to a position near the bottom of the display such that the Tilt 

angle is around 30°. This provides a reasonable perspective of where Ceres is compared to 

the other planets. 

 

Now, imagine drawing a line from the Sun to the Ascending Node (towards the upper 

right-side of the image where the darker orbital path of Ceres changes to the brighter 

orbital path (the opposite node is descending since objects orbit around the Sun counter-

clockwise as viewed from the top). 

 

 
 

 

 

Next imagine drawing an arc starting at the red line (First Point of Aries) counter-

clockwise around to the line from the Sun, as shown below. 

 



 
 

The angle of that arc is called the Longitude of Ascending Node and in this case for 

asteroid Ceres you can see in the orbital elements shown previously, that the Longitude of 

Ascending node (node) is approximately 80°.  This appears to be visually correct since a 

quarter circle would is 90°. 

 

It is important to understand that this angle, the Longitude of Ascending Node is in the 

same plane as Earth and Sun – the Ecliptic plane.  

 

Next, we need to locate the Perihelion of the orbit of Ceres. This is the point where Ceres 

is closest to the Sun. The Perihelion of the orbit can be found by going back to the View 

menu and clicking Show Perihelion, Aphelion Points. 

 

  
 

The screen will then show the following.  

 



 
 

Note the two points on the orbital path of Ceres marked 'peri' and 'aph'.  

Now, imagine drawing a line from the Sun to the point of Perihelion and then drawing an 

arc from the Ascending Node to that line. That arc or angle is called the Argument of 

Perihelion (peri). 

 

 
 



If you look in the orbital elements that were shown above, you will see that the Argument 

of Perihelion (peri) is approximately 73°. This again appears to be visually correct. 

 

It is important to understand that this angle, the Argument of Perihelion (peri) is NOT in 

the same plane as Earth and Sun – the Ecliptic plane. It is NOT in the same plane as the 

Longitude of Ascending Node (node). 

 

This is important because the Longitude of Ascending Node and the Argument of 

Perihelion cannot be added together as a simple sum of angles. Because of the inclination, 

the two angles exist in different planes (shown below). They can only be added if the orbit 

of the minor planet is in the same plane as the ecliptic. 

 

 
 

The next step is to draw a line from the Sun to an imaginary point on the orbital path 

called the Mean Anomaly (M). Then draw an arc from the Perihelion to that line. That arc 

or angle is called the Mean Anomaly (M). Since the Mean Anomaly is approximately 231° 

(at the Epoch date 2461000.5 JD) then that arc will continue along the orbit of Ceres, 

through the descending node, into the second half of the orbit and then back into the first 

half of the orbit of Ceres, past the First Point of Aries.  

 

 

 



Note in the image below, the Mean Anomaly point is close to Ceres, but not actually at 

Ceres. 

 

 
 

We can see that the Mean Anomaly is close to the True Anomaly (True Position of Ceres) 

but not exactly. The Mean Anomaly is based on the mean daily motion (n) times the 

number of days since the asteroid passed the Perihelion. The problem is that according to 

Kepler's Laws, an orbiting object does not have a constant speed - it goes fast and slow 

depending on where it is in its orbit. Therefore, we just use an average speed - and that 

gives us the Mean Anomaly. The True Anomaly (actual position) is derived by first solving 

Kepler's Equation to get what is called the Eccentric Anomaly, and from that we calculate 

the True Anomaly. We will take a look at how to calculate the Eccentric Anomaly and the 

True Anomaly next. 

 

Throughout all of this you need to keep in mind that the Mean Anomaly above was 

calculated at the Epoch of 2025/11/21 at 0 hours UT (Julian Day 2461000.5). As the days 

advance Ceres continues to move along the orbital path and so these additional days 

would have to be included in the calculation of the Mean Anomaly. 

 

When you combine these orbital elements ( i,  Ω , ω , M ) with the remaining other orbital 

elements (Semi-Major Axis a, Eccentricity e) you have a full set of coordinates to describe 

the heliocentric position of any orbiting object around the Sun. 

 



A Bit of Math Regarding the Mean Anomaly 

 

Let te represent the Epoch Date and tp represent the time and date at which the asteroid 

(or comet) is passing the point of Perihelion (the point closest to the Sun). From these two 

dates we calculate the number of days from Perihelion to the Epoch, ie.,  number of days 

= te - tp . This is generally calculated using the Julian Day Number for both te and tp. 

 

Also, let n represent the average speed that the object is moving (in terms of degrees per 

day). It is also called Mean Daily Motion. 

 

Let Mo represent the Mean Anomaly. This is the angle (in degrees) that the object has 

traveled from the time of the Perihelion (tp) to the time of the Epoch (te).  Use the 

equation:  Mo = n * (te - tp)   to calculate the Mean Anomaly.      

 

Mo is the value of M at the Epoch. 

tp is the time of Perihelion passage (in Julian Day Number). 

te is the number of days from tp to the Epoch Date. 

n is the average speed (degrees per day) or Mean Daily Motion. 

 

The Period (P) of the orbit is the number of days it takes for the object to make a 

complete orbit around the Sun.  The Period can be calculated using one of Kepler's Laws: 

The square of the period P of any planet is proportional to the cube of the Semi-Major 

Axis (a) of its orbit. Therefore, solve for P given P2  =  a3     

 

When we calculate P in terms of Earth's orbit: P = 365.256898326  * a3/2  days. 

If we know the Semi-Major Axis (a) of an object, we can solve for P; or, we can just count 

the number of days for a complete orbit. 

 

Now that we have P, we can solve for the Mean Daily Motion (n). Since an object moves 

through 360 degrees in one orbit then the Mean Daily Motion is  

n = 360 / Period  ( degrees per day). 

 

Therefore,  Mo = (360 / Period) * (te - tp) 

  

Epoch is the date at which all the orbital elements were last calculated (in Julian Day 

Number).   

 

 



If we want to know the Mean Anomaly (M not Mo) at a later date (the object has moved 

farther along its orbit) then we use the same type of calculation.  

 

M is the Mean Anomaly at any arbitrary date. Instead of (te - tp) we use (t - te) where t is 

typically the present date (or any arbitrary date). 

 

Then at any arbitrary date, M = n * (t - te) + Mo    where again t is typically the present 

date. If we combine (t - te) and (te - tp) then we can skip Mo and say: 

M = n * (t - tp). 

 

One last detail, if the Epoch Date is the same as the Perihelion Date (ie. te = tp). This 

means that since Mo = n * (te - tp)  and te - tp = 0 then  

Mo = 0. In this case you would use M = n * (t - tp). 

 

Now that we understand the Mean Anomaly, let's move on to the Eccentric Anomaly and 

the True Anomaly, the actual position of the object. 

 

                  
 

Before we solve for the True Anomaly () we need to understand the Eccentric Anomaly 

(E). 

 

In the figure below, imagine the elliptical path of an orbit with planet P, all enclosed by a 

circle. Draw a line from the center up to the circle such that a triangle is formed with the 

vertical side passing down through the planet P. The angle E that is formed is then called 

the Eccentric Anomaly.  

  



   
 

The Eccentric Anomaly (E) is related to the Mean Anomaly (M) by Kepler's Equation: 

     

          M = E - e * sin(E)     where M and E are in radians 
 

 

 

Once Kepler’s Equation is solved for the Eccentric Anomaly, the relation between the 

Eccentric Anomaly (E) and the True Anomaly () is: 

 

   where e is Eccentricity 

 



 
 

Now look at it again to see how it all fits. The Sun is at a focal point, not at the center. 

        

If the Sun was at the center, the orbit would be a circle and the Mean Anomaly, the 

Eccentric Anomaly and the True Anomaly would all be the same angle pointing to the 

same object on the orbital path, but, this is very rarely the case. 

 

For the vast majority of cases where the orbit is not a perfect circle, we need to first solve 

for the Mean Anomaly (M). Second, use M and Kepler's Equation to solve for the 

Eccentric Anomaly (E), and third, use E to solve for the True Anomaly (). 

 

Kepler's Equation ( M = E - e * sin(E) ) cannot be solved algebraically. It is usually solved by 

using iteration methods with a computer. This method is called the Newton-Raphson 

Method and involves finding the roots of the equation (see Appendix): 

 

       f(E) = E - e*sin(E) - M 

 

Note: if using a computer program to solve this equation, E and M are measured in 

radians, this equation does not work for degrees. To solve for the roots, set f(E) = 0 

 

 



Ok, now let’s return to the previous problem of calculating the True Anomaly of Ceres 

given the orbital elements as before, and this time our calculations will be more precise 

instead of just approximations. 

 

Arg of perihelion = 73.29974° = 1.27932 Radians 

Mean anomaly at epoch (M) = 231.53975 ° = 4.041131 Radians at Date of Elements 

Date of Elements (Epoch) is 2461000.5 JD or November 21, 2025. 

Eccentricity (e) = 0.0795753  

 

Use Kepler's Equation (M = E - e * sin(E) ) to get E 

Refer to python code in the Appendix for solving Eccentric Anomaly. 

It is found that E = 228.14382° = 3.98186 Radians 

 

 

Now use the Eccentric Anomaly (E) to calculate the True Anomaly 

 

 
  

 = 2 * arctan( sqrt((1+0.0795753)/(1-0.0795753)) * tan(228.14382/2)) 

 = 2 * arctan(sqrt(1.1729099) * tan(114.07191) ) 

   = 2 * arctan(1.083009 * (-2.23847) ) 

 =  -135.1684°   

A negative angle might seem strange. It means going backward (clockwise) from 

Perihelion back to Ceres.   

 

To go forward from the Perihelion in the direction of the orbit (counter-clockwise), the 

True Anomaly () = 360.0 – 135.1684 = 224.8316°  

 



 
 

 

Take a look at Sun Moon Planets Simulation menu item Orbits || SkyView with Orbiting 

Planets. Find Ceres (to compare with results shown here, make sure you set the date to 

Nov. 21, 2025). Also check menu item Dialogs || Ecliptic View; again, find Ceres.  

 

Now that we have discussed the meaning of all six orbital elements, we next consider the 

concepts of Right Ascension (RA) and Declination (Dec). 

 

To ty the orbital elements to RA and Dec, when we check the Minor Planet Center 

ephemeris for Ceres on Nov. 21, 2025, the Right Ascension is 0h 27m 15.5s and the 

Declination is -10° 12' 3" 

 

Remember, the First Point of Aries (Vernal Equinox) is defined as RA = 0 hours, 0 minutes, 

0 seconds (0h 0m 0s) and Dec = 0 degrees, 0 arcminutes, 0 arcseconds (0° 0' 0"). So, since 

Ceres is very close to that, all looks well.  

 

 

 

 

 

 

 



6: Right Ascension and Declination – An Overview 
 
Right Ascension (RA or Greek letter α) is the angular distance of an object (like a 

planet or star) that is east of the First Point of Aries (Vernal Equinox or ♈) and is 

measured along the Celestial Equator. The angle is measured in hours, minutes and 
seconds (h,m,s). 

 
Declination (Dec or Greek letter δ) is the angular distance of an object that is north 

or south of the Celestial Equator. The angle is measured in degrees 

( ° ), minutes ( ' ), and seconds ( " ). The Celestial Equator is 0° Dec and the poles are 

+90° (north) and -90° (south). 

 

Where is the First    

Point of Aries? 

It is now in the 

constellation Pisces. 

Just click menu 

item Dialogs and 

select Ecliptic 

View. In the dialog 

box note the 

location of RA = 0 

hours and 

Dec = 0°. You 

should see the 

constellation Pisces 

just above that 

point. 

https://en.wikipedia.org/wiki/Degree_(angle)
https://en.wikipedia.org/wiki/Minute_of_arc
https://en.wikipedia.org/wiki/Minute_of_arc


In the figure above there are several items that need to be clearly understood. 

• Imagine that the Earth is at the center. The equator of the Earth 

extends out into space as the Celestial Equator. The north and 

south poles of the Earth also extend out as the North Celestial Pole 

and the South Celestial Pole (see blue line above). 

• The Earth revolves around the Sun in a plane that is tilted at 

approximately 23.5° with respect to the Celestial Equator. This 

plane is called the Ecliptic. The Ecliptic also has a North Ecliptic Pole 

and a South Ecliptic Pole (see red line above). 

• Note the point where the Ecliptic rises through the Celestial 

Equator. Observe the green line from the Earth to that point. That 

line points in the direction of the First Point of Aries (Vernal 

Equinox or ♈). That direction is where the Right Ascension (RA) is 

equal to 0h, 0m, 0s and the Declination (Dec) is 0°, 0', 0". 

• The First Point of Aries is our starting point. Now imagine a planet 

or star in the sky. The coordinates of that object would be stated in 

terms of RA and Dec. To get RA, move counter-clockwise from the 

Vernal Equinox along the Celestial Equator. That angle is shown in 

the figure above as α. Next, move up (northward) from the 

Celestial Equator to the object. That angle is shown in figure above 

as δ. 

Examples of Using RA and Dec in the Celestial Sphere 

 
Open the program Sun, Moon, Planets Simulation. On the main screen you should 

see the position of the planets orbiting the Sun. Also note the red line from the Sun 

pointing down and to the right side of the screen. That line is pointing towards the 

First Point of Aries. That is the direction for which α= 0h, 0m, 0s and δ= 0°, 0',0". 

 

 
Using the Tools menu item, click Select a Date. In the dialog box, enter the date 

2025, March 20 and click the button Set/Reset Date. Then click the OK button. 



 

 
Look at the position of the planets on the main screen. Note in green at top left that 

Earth is at Spring Equinox. Also note that Earth is in-line with the Sun and opposite 

the First Point of Aries. 

 



Next, select menu item Tables and Planet Tables. From that dialog box select the 

tab Earth Equinox / Solstice Dates as shown below. 

 

 

 
Note in the text box the date and time of the March Equinox - it is 2025/03/20 at 

09:01. The location is for the Prime Meridian. So, at that instant of time, the Sun 

would be rising through the Earth's Celestial Equator. It is at that instant of time 

that Spring begins. At a different location (such as Toronto, Ontario) the first day of 

Spring would have begun five hours later. Toronto is five hours behind the Prime 

Meridian (Greenwich Mean Time, GMT) during Standard Time (EST), and four hours 

behind during Daylight Saving Time (EDT).  

 
To get a different view of this event, adjust the orbit scale (Tools || Orbit Scale) to 

about 250% and then use the vertical slider to set the Tilt to 0°. Look closely to see 

the Earth and the Sun directly in line with the First Point of Aries. 

 

 



In the flat view above, what you are looking at is edge-on of the Ecliptic plane. Note 

the line connecting the Earth and the Sun. The other planets are very close to this 

plane.  

 
For another view point select menu item Dialogs and then Ecliptic View. This brings 

up a dialog box that shows RA on the horizontal axis and the Dec on the vertical 

axis. In this dialog box, set the date to 2025, March 20. 

 

 

 
In the dialog box you can see the position of the planets, the Moon, and the Sun, all 

generally following along the Ecliptic (blue line). Note that the Sun is located at 

RA = 24 hours and Dec = 0°. If you add one more day the Sun appears at 0 hours 

(RA). 24 hours and 0 hours are the same. The Sun is at the First Point of Aries. 

 
The First Point of Aries is a location; the March Equinox, Spring Equinox, Vernal 

Equinox is the date at which the Sun is at the First Point of Aries. 

 
When the Sun is at 0 hours RA and 0° Dec then it is the Spring Equinox. Now if you 

go back to the main screen and change the Date to 2025, September 22 then you 

will see that the Earth is again in-line with the Sun but this time it is on the opposite 

side, between the Sun and the First Point of Aries. 

 

 



 
Note in the top, left corner of that screen, the green text states the Earth is at Fall Equinox. 
 

 

 

 
If you click menu item Dialogs and Ecliptic View and then in the dialog box set the 

date to 2025, September 22 (same as on the main screen). Note that the Sun is now 

right in the middle at RA = 12 hours and Dec = 0°. 

 

Note, the Moon check box is switched off as the Moon is mostly blocking the Sun on 

that date. You will see why if you go to Orbits || Earth Moon Sun and set the date 

to Sept 22, 2025. 



 

 

 

 

 

For the Solstices, first set the main screen date to 2025, June 21st. 

On the main screen note that it is the date of the Summer Solstice and the position 

of the Earth is at 90° to the left of the Sun - or, the Sun is at 90° to the right of the 

Earth. Observe that the horizontal slider (rotation) has been moved to 120°. 



 

 

 

 
If you click menu item Tools and Ecliptic View and then in the dialog box set the 

date to 2025, June 21st (same as on the main screen). Note that the Sun is now at 

RA = 6 hours and Dec is approximately 23° (at its highest point). 

 
Keep this 6 hours of RA in mind for a few minutes. 
 
 



 
 
 
A bit of explanation here - Right Ascension (RA) runs from 0 hours to 24 hours 

similar to a clock. There are 360° degrees in a circle, same as the Earth orbiting the 

Sun. Therefore 24 hours corresponds to 360°. This means 

1 hour of RA = 360° / 24 hours. Or, in other words, 1hour of RA corresponds to 15°. 

So, therefore 6 hours RA corresponds to 90° as is shown on the main screen. 

 

 

 
Now, let's look at the last one, the Winter Solstice. Set the date on the main screen 

for 2025, December 21. Note the position of the Earth relative to the Sun. This time 

it's on the opposite side at 90° so that the Sun is to the left of the Earth. 



 

 
In the Ecliptic View, the Sun is at 18 hours RA. Note the check box for Planets is unchecked; 
this was necessary to see the Sun at 18 hours without being blocked by the planets. 

 



So, as the Earth revolves around the Sun throughout the year, the Sun appears to 

orbit the Earth and occupy a different position of Right Ascension (RA) and 

Declination (Dec) each day. This should not be confused with the apparent motion 

of the Sun as it rises and sets each day - this is due to the Earth's rotation on its axis, 

not on the Earths revolution around the Sun throughout the year. 

 
To better understand this, suppose you were to pick any particular time of day (e.g. 

12:00 noon) and observe the position of the Sun at the same time every day 

throughout the year. You would notice that the Sun appears to have slight changes 

in position at that same time every day. This is due to the revolution of the Earth 

around the Sun, not to the rotation of the Earth. 

 
What we can take away from this is that from our position on Earth we can identify 

the position (RA and Dec) of any object in the sky including the Sun, Moon, planets, 

asteroids, comets, stars, etc. This gives every object in the sky a defined position 

that is not dependant on your latitude or longitude. This makes it much easier to 

communicate the position of an object to others without including your own 

particular latitude and longitude. It also allows you to standardize the position of 

objects such as stars that are very far away. For example, Betelgeuse (in the 

constellation Orion) has a Right Ascension of 5h 55m 10.3 s and a Declination of 

+7° 24' 25.4". It’s position does not change. 

 
But, as we have seen, celestial objects (within our solar system) are much closer and 

so when we state their position, it depends on the position of the Earth as it orbits 

around the Sun and also the position of that object as it orbits the Sun. For example: 

2019, August 26, Mars is at RA = 10h 28m 47s and Dec +10° 43'24"; but later on 2019, 

September 26, Mars is at RA = 11h 42m 17s and Dec +3° 0' 31". 

 

 
On the main screen set the date again for 2019, March 20 (although the following 

exercise can be done for any date). Next, move the vertical slider to the bottom so 

that Tilt is at 90° and then the horizontal slider so that Rotation is 120°. Here is 

what the main screen should look like. 



 

 
Note, the red line pointing to the First Point of Aries is straight down. 

 
Now, imagine a 24 hour Right Ascension clock around the Earth as shown below. 

The circle around Earth is marked off at 0 hours (at the bottom), 6 hours, 12 hours 

(at the top), 18 hours, and back to 0 hours. 

 
On this date, from the view at Earth, the Sun is at 0 hours. The angular position of 

Mars appears about halfway between 0 hours and 6 hours, so a quick estimate 

might be around 3 hours. A quick estimate of Venus might be around 21 to 22 hours 

and for Mercury around 23 hours. If you go to the Planet Tables and check the 

Planet Ephemerides for Mars, Venus, and Mercury for 2019, March 20, you should 

see that those approximations are reasonably accurate. 



 

 
 

 

Also, if you bring up the dialog box for the Ecliptic View, set the date for 2019, 

March 20 and then look for the RA and Dec of those three planets. Again, Mars is 

around 3 hours RA, Venus is around 21 to 22 hours and Mercury is about 23 hours. 



 

 
Any time you look at the main screen, note the position of Earth and the other 

planets. Imagine the 24 hour Right Ascension clock with 0 hours straight down and 

12 hours straight up. Then try to guess at the RA of the planets relative to the Earth. 

To check your guess just go to the Planet Tables and select the Ephemerides tab, 

set the date and select the planets. Compare your approximations of RA with those 

in the table. 

 
Try any different date - for example, set it to 2019, June 5. Make sure the red line for 

the First Point of Aries is pointing straight down. 

 
Check the figure below. In this position, the view from Earth, the Sun appears to be 

around 5 hours (RA). The angular position of Mars appears to be about 7 hours. A 

quick estimate of Venus might be between 3 and 4 hours and for Mercury around 6 

hours. If you go to the Planet Tables and check the Planet Ephemerides for Mars, 

Venus, and Mercury for 2019, June 5 you should see that those approximations are 

reasonably accurate. Also, the Ephemerides in the Sun Tables (set the date) shows 

the Sun to be 4h 50m 55s, very close to the estimated 5 hours. 



 

 
If you bring up the Ecliptic View and make sure the date is the same, 2019, June 5, 

you should note the Sun appears to be around 5 hours, Venus is close to 4 hours, 

Mars at 7 hours, and Mercury at 6 hours. 

 
So, using the Sun Moon Planet Simulation allows you to very quickly get an 

estimate of the position (RA) of the Sun, Moon, or planets on any date. Just move 

the red line straight down and imagine a Right Ascension clock around Earth. 

 
When you are outside observing the night sky, if you know the fixed RA of a well-

known star, and the current RA of a planet, you can use the star to quickly find the 

planet. Keep in mind that 1 hour of RA is equal to 15°. 

 

 

 

 

 



For example, Betelgeuse (in the constellation Orion) is a well-known star, easy to 

find, and has a Right Ascension of approximately 6 hours and is a bit below the 

Ecliptic. On 2019, June 5, we find in this program that Mars is positioned around 7 

hours. If you went outside at night on that date, found Betelgeuse, looked up a bit 

and about 15° to the left (east), there was Mars. 

 
On June 5, 2019, the difference between Mars at 7 hours and Betelgeuse at 6 hours 

is 1 hour. Recall that 1 hour of Right Ascension is equivalent to 15°. 

 

 

 

You can verify this observation right in Sun Moon Planets Simulation. Go to menu 

item Orbits || Sky View with Orbiting Planets. Make sure the date is set to 2019, 

June 5. Adjust the slider along the bottom of the window to about 10 hours. Now, 

find the star Polaris (North Star) and note that an RA clock surrounds it. Follow the 

clock line marked 6 hours down below the ecliptic to find Betelgeuse. Then back up 

to the ecliptic line (orange) and to the East, you should see Mars – at about 7 hours 

according to the clock around Polaris. Finally, if you go to the Planet Tables, 

Ephemeris you should see Mars at 6 h 56m for June 5, 2025. 

 



 
 

 
Precession 

 
Refer to the First Point of Aries at RA = 0 hours and Dec = 0° (see Vernal Equinox 

on the right-side below). At this point the Ecliptic (blue line) and the Celestial 

Equator (red line) intersect. As shown below, Right Ascension increases east (left) 

of that point. This is the point where the Sun appears to cross the Celestial Equator 

going north (+ Dec.) and the length of day and night are equal. This is the date of 

the Vernal Equinox. 



 

 

 
To see this dialog box, click menu item Dialogs and select Ecliptic View. 

Why is the First Point of Aries now located in the constellation Pisces? Observe in 

the dialog box the location of RA = 0 hours and Dec = 0°. You should see the 

constellation Pisces (light gray letters) near that point. If you look carefully in the 

dialog box, Aries is a bit above Pisces and east (left) of it. The First Point of Aries 

used to be in the constellation of Aries but has moved westward (to the right) 

towards the constellation Pisces. The First Point of Aries (vernal equinox) was in 

the constellation Aries about 2,000 years ago and slowly moved into the 

constellation Pisces. The change was caused by Earth's axial wobble (precession), 

putting it now in Pisces.  

https://www.google.com/search?q=vernal+equinox&rlz=1C1UEAD_enCA971CA971&oq=how+long+ago+was+the+first+point+of+Aries+in+the+constellation+aries%2C+it+is+now+in+pisces&gs_lcrp=EgZjaHJvbWUyBggAEEUYOdIBCjQ5MTA4ajBqMTWoAgiwAgHxBZL4unpF5Td4&sourceid=chrome&ie=UTF-8&mstk=AUtExfALsgiUVHk0a8WTfpu5YWR0JzeA4n0nhLkxG-JACc8HsdubELq7zgA6ITXllYp8vi3uswSp6jvQ742elnaKpggrY21ta4e1LqiEBiy-FM8SFa8Xus4gfMvl_dUpe729748&csui=3&ved=2ahUKEwjlo-y9qMCRAxV0CjQIHZGFL_QQgK4QegQIAhAB
https://www.google.com/search?q=precession&rlz=1C1UEAD_enCA971CA971&oq=how+long+ago+was+the+first+point+of+Aries+in+the+constellation+aries%2C+it+is+now+in+pisces&gs_lcrp=EgZjaHJvbWUyBggAEEUYOdIBCjQ5MTA4ajBqMTWoAgiwAgHxBZL4unpF5Td4&sourceid=chrome&ie=UTF-8&mstk=AUtExfALsgiUVHk0a8WTfpu5YWR0JzeA4n0nhLkxG-JACc8HsdubELq7zgA6ITXllYp8vi3uswSp6jvQ742elnaKpggrY21ta4e1LqiEBiy-FM8SFa8Xus4gfMvl_dUpe729748&csui=3&ved=2ahUKEwjlo-y9qMCRAxV0CjQIHZGFL_QQgK4QegQIAhAD


Precession can be described as the wobble in the rotational axis of a 

rotating body (such as a top, or the Earth). Earth's precession has resulted 

in the equinoxes slowly moving westward relative to the background stars. 

In other words, the Ecliptic itself is moving westward. Precession is a 

result of the Earth's rotation and the gravitational pull of the planets, the 

Moon and the Sun. The Moon and the Sun are by far the most significant 

cause of precession. 

 
The rate of precession is about 1 degree every 71.6 years (or 50.3 seconds 

of arc per year). In 14000 AD the Earth's axis will be pointing at Vega. For 

the Earth to complete a full cycle of 360° will take nearly 26000 years. At 

that time Polaris would be the North Star again. 

 
The point at where the Sun crosses the Celestial Equator heading north 

along the Ecliptic is in the direction of the First Point of Aries. In 150 B.C. 

when Ptolemy (Almagest) mapped the constellations, Aries was in that 

position. 

 

 

 

 

 

 

 



 

 

 

Appendix 
 

Python Apps: 

To use these python scripts, copy them and save them using Notebook. Save 

them as filename.py. Then, at the Windows Command Prompt (CMD), type  

python filename.py   (Make sure filename.py is in the proper directory otherwise 

it won’t run – you might want to save the filename.py to your Desktop and then 

when you open Windows Command Prompt (CMD), change the directory from 

C:\Users\Owner to C:\Users\Owner\Desktop  - this is done by using the 

command cd Desktop ,   then at the prompt type python filename.py ) 

 

A. Converting Julian Day Number 

Before running this script, you must install astropy. 

At the Windows Command Prompt (CMD) type pip install astropy 

 

from astropy.time import Time 

import datetime 

 

# From Gregorian to JD 

dt = datetime.datetime(2025, 12, 25, 0, 0, 0) 

t = Time(dt, scale='utc') 

print(f"JD using astropy: {t.jd}") # Output: 2461034.5 

 

# From JD to Gregorian 

t_jd = Time(2461034.5, format='jd', scale='utc') 

print(f"Date using astropy: {t_jd.datetime}") 

 

 

 

 

 

 



B. Converting Degrees and Radians 

(reference: google.com, search converting degrees and radians python) 

 

import math 

#Degrees to Radians: Use math.radians(). 

degree_value = 90 

radian_value = math.radians(degree_value) 

print(radian_value) 

# Output: 1.5707963267948966 (which is approximately π/2) 

#Radians to Degrees: Use math.degrees(). 

radian_value = math.pi # Use the constant for pi 

degree_value = math.degrees(radian_value) 

print(degree_value) 

# Output: 180.0 

 

 

C. Newton-Raphson Method for Solving Keplers Equation 

(reference: google.com, search solve keplers equation python) 

 

import numpy as np 

 

def solve_kepler(M, e, tolerance=1e-10, max_iter=100): 

    """Solves Kepler's Equation (M = E - e*sin(E)) for E using Newton's 

method.""" 

    # Initial guess for E (often M is a good start, or use Machin's 

approximation for better speed) 

    E = M + e * np.sin(M) # A simple starting point 

     

    for _ in range(max_iter): 

        f_E = E - e * np.sin(E) - M # The function we want to be zero 

        f_prime_E = 1 - e * np.cos(E) # The derivative of f_E 

         

        delta_E = f_E / f_prime_E # Newton-Raphson step 

        E -= delta_E 

         



        if abs(delta_E) < tolerance: 

            return E # Converged 

     

    # If it doesn't converge within max_iter 

    print("Warning: Kepler solver did not converge.") 

    return E 

 

# --- Example Usage --- 

mean_anomaly_rad = np.radians(231.53975) # M in radians (e.g., 100 

degrees) 

eccentricity = 0.0795753  # e for the orbit 

 

eccentric_anomaly_rad = solve_kepler(mean_anomaly_rad, 

eccentricity) 

print(f"Mean Anomaly (M): {np.degrees(mean_anomaly_rad):.2f} 

deg") 

print(f"Eccentricity (e): {eccentricity}") 

print(f"Eccentric Anomaly (E): {np.degrees(eccentric_anomaly_rad):.2f} 

deg") 

 

# Verify (M should be close to E - e*sin(E)) 

calculated_M = eccentric_anomaly_rad - eccentricity * 

np.sin(eccentric_anomaly_rad) 

print(f"Verification (Calculated M): {np.degrees(calculated_M):.2f} 

deg") 

 

 

 
 


